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Introduction

LibreOffice can be used without requiring a pointing device, such as a mouse or trackball, by 
using the keyboard shortcuts that are available in Impress. Tasks as varied and complex as 
docking and un-docking toolbars and windows, or changing the size or position of objects can all 
be accomplished with using keyboard shortcuts. Although LibreOffice has an extensive set of 
keyboard shortcuts, each LibreOffice module has keyboard shortcuts that are specific to that 
module. For help with LibreOffice keyboard shortcuts, or using LibreOffice with a keyboard only, 
search the LibreOffice Help using the “shortcut” or “accessibility” keywords.

In addition to using keyboard shortcuts that are listed in this appendix, keyboard shortcuts can 
also be user defined. Assign keyboard shortcuts to standard Impress functions or macros and 
save them for use with Impress only, or with the other modules in LibreOffice. To customize 
keyboard shortcuts, see the Getting Started Guide for more information.

macOS keyboard shortcuts

Some keystrokes and menu items are different on a macOS computer from those used in 
Windows or Linux computers. This due to the way the different operating systems work and the 
different types of keyboards used. Also, the labelling on the keyboards may vary depending on 
the age of the computer and style of keyboard being used. The following information shows the 
most common variations in keyboard shortcuts and keyboard labelling.

Shift, Control and Alt keys

Windows or Linux macOS

Control or Ctrl  or ⌘ Cmd or Command

Alt  or ⌥ Option or Alt

Shift or ⇧ Shift or ⇧

Caps Lock  or ⇪ Caps Lock

Control or Ctrl  or ⌃ Control or Ctrl

Home and End keys

Windows or Linux macOS

Home Fn+Left Arrow

End Fn+Right Arrow

Page Up and Page Down

Windows or Linux macOS

Screen Up Fn+Up Arrow

Page Up  or ⌥ Option or Alt+Fn+Up Arrow

Screen Down Fn+Down Arrow

Page Down  or ⌥ Option or Alt+Fn+Down Arrow
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Impress keyboard shortcuts

Note

Some keyboard shortcuts are not available for computers using macOS and are 
indicated in the following tables by a blank cell.

Impress functions

Windows or Linux macOS Effect

F2 F2 Switches to text edit mode and opens the Text 
Formatting toolbar.

F3 F3 Enter and edit a group of objects.

Ctrl+F3 ⌘+F3 Exit a group of objects.

Shift+F3 Shift+F3 Opens the Duplicate dialog of a selected object.

F4 F4 Opens the Position and Size dialog of a selected 
object.

Alt+Shift+F5 +⌥ Shift+F5 Opens Notes view and displays the first slide in the 
slide show.

Ctrl+Shift+F5 +⌘ Shift+F5 Opens the Navigator.

F7 F7 Start spelling checker.

Shift+F7 Shift+F7 Switches on or off the automatic spell checking.

Ctrl+F7 +⌘ F7
Opens the Thesaurus dialog for the language being 
used. Impress has to be in text editing mode to 
access the thesaurus.

F8 F8 When selected, opens the Edit Points toolbar.

Ctrl+Shift+F8 +⌘ Shift+F8 Fit text to frame of a selected object.

F11 +⌘ T Open the Styles deck on the Sidebar.

Slide shows

Windows or Linux macOS Effect

F5 F5 Starts a slide show.

Shift+F5 Shift+F5 Starts a slide show at the slide where the slide show 
was previously stopped at.

Left click Left click Shows the next slide, or plays the next animation 
effect on a slide.

Right Arrow Right Arrow Shows the next slide, or plays the next animation 
effect on a slide.

Page Down +⌥ Fn+Down Arrow Shows the next slide, or plays the next animation 
effect on a slide.

Spacebar Spacebar Shows the next slide, or plays the next animation 
effect on a slide.

Enter Enter Shows the next slide, or plays the next animation 
effect on a slide.

Right click Right click Shows the previous slide, or plays the previous 
animation effect on a slide.
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Windows or Linux macOS Effect

Left Arrow Left Arrow Shows the previous slide, or plays the previous 
animation effect on a slide.

Up Arrow Up Arrow Shows the previous slide, or plays the previous 
animation effect on a slide.

Page Up +⌥ Fn+Up Arrow Shows the previous slide, or plays the previous 
animation effect on a slide.

Backspace Backspace Shows the previous slide, or plays the previous 
animation effect on a slide.

Home Fn+Left Arrow Go to first slide in the slide show.

End Fn+Right Arrow Go to the last slide in the slide show.

Alt+Page Up +⌥ Fn+Up Arrow Go to the previous slide without playing any animation
effects.

Alt+Page Down +⌥ Fn+Down Arrow Go to next slide without playing any animation effects.

B or . (period) B or . (period) Show black screen until next key or mouse wheel 
event.

Esc or – (minus) Esc or – (minus) Stop and close the slide show.

[Number] Enter [Number] Enter Type the number of a slide and press Enter to show 
the slide.

Impress shortcuts

Windows or Linux macOS Effect

Plus (+) Plus (+) Zoom in.

Minus (-) Minus (-) Zoom out.

Times (×) on 
number pad

Times (*) on 
number pad

Fits the slide to fill the Workspace view.

Divide (/) on 
number pad

Divide (/) on 
number pad

Zooms in on the selected object.

Ctrl+Shift+G +⌘ Shift+G Group selected objects.

Shift+Ctrl+Alt+G +⌘ Shift+ +G⌥ Ungroup selected group.

Ctrl+click ⌘+click Enter a group to edit individual objects in the group.
Click outside the group to return to normal view.

Ctrl+Shift+G ⌘+Shift+G Combine selected objects.

Ctrl+Shift+Alt+K ⌘+Shift+⌥+K Split a selected object that has been combined 
from a group of two or more objects.

Ctrl++ ⌘++ Bring to front.

Ctrl +Shift++ ⌘+Shift++ Bring forward.

Ctrl+- ⌘+- Send backward.

Ctrl+Shift+- ⌘+Shift+- Send to back.

Arrow Arrow Moves a selected object in the direction of the 
arrow.

Ctrl+Arrow ⌘+Arrow Moves a slide within the Workspace when no 
objects are selected.
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Windows or Linux macOS Effect

Shift and drag Shift and drag Constrains movement of a selected object horizontally
or vertically when dragged.

Shift and drag Shift and drag
Hold down Shift, then click on a selection handle 
and drag when resizing an object to maintain the 
proportions of the object.

Ctrl+Click and 
drag

⌘+Click and drag
Hold down the Ctrl ( ) key, then click and drag a⌘
selected object to create a copy of the object.

Alt+Click and drag ⌥+Click and drag
Hold down the Alt ( ) key and draw or resize an ⌥
object from the centre of the object.

Alt+Click ⌥+Click Select an object that is behind the currently 
selected object.

Alt+Shift+Click ⌥+Shift+Click Select an object that is in front of the currently 
selected object.

Shift+Click Shift+Click

Selects several adjacent objects or characters. 
Click at the start of a selection, move to the end of 
the selection, and then hold down Shift while you 
click.

Tab Tab Select objects in the order in which they were 
created.

Shift+Tab Shift+Tab Select objects in the reverse order in which they 
were created.

Esc Esc Exit current mode.

Page Up ⌥+Fn+Up Arrow Switch to the previous slide. No function on the first
slide.

Page Down ⌥+Fn+Down Arrow Switch to the next slide. No function on the last 
slide.

Enter Enter Activate a place-holder object in a new presentation
(only if the frame is selected).

Ctrl+Enter ⌘+Enter

If there are no text objects on the slide, or the last text 
object is reached, a new slide is inserted after the 
current slide. The new slide uses the same layout as 
the current slide.

Editing text

Windows or Linux macOS Effect

Ctrl+- ⌘+- Inserts a custom hyphen in text at the cursor position. 
Also known as a soft hyphen.

Ctrl+Shift+- ⌘+Shift+- Inserts a non-breaking hyphen in text at the cursor 
position. Also known as a hard hyphen.

Ctrl+Shift+Space ⌘+Shift+Space
Non-breaking spaces. Non-breaking spaces are not 
used for hyphenation and are not expanded if the text 
is justified.

Shift+Enter Shift+Enter Line break without paragraph change.

Left Arrow Left Arrow Moves the cursor one character to the left.
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Windows or Linux macOS Effect

Shift+Left Arrow Shift+Left Arrow Moves the cursor one character to the left and selects 
the character.

Ctrl+Left Arrow ⌥+Left Arrow Moves the cursor to the beginning of the previous 
word.

Ctrl+Shift+Left 
Arrow

⌥+Shift+Left 
Arrow

Moves the cursor to the left and selects the word on 
the left.

Right Arrow Right Arrow Moves the cursor one character to the right.

Shift+Right 
Arrow

Shift+Right 
Arrow

Moves the cursor one character to the right and 
selects the character.

Ctrl+Right Arrow ⌥+Right Arrow Moves the cursor to the beginning of the next word.

Ctrl+Shift+Right
Arrow

⌥+Shift+Right 
Arrow

Moves the cursor to the right and selects the word on 
the right.

Up Arrow Up Arrow Moves the cursor up one line.

Shift+Up Arrow Shift+Up Arrow Moves the cursor up one line in the text and selects 
the lines of text.

Ctrl+Up Arrow ⌥+Up Arrow Moves the cursor to the beginning of the paragraph.

Ctrl+Shift+Up 
Arrow

⌥+Shift+Up 
Arrow

Moves the cursor to the beginning of the paragraph. 
Selects the text in the paragraph from the cursor 
position to the beginning of the paragraph.

Down Arrow Down Arrow Moves the cursor down one line.

Shift+Down Arrow Shift+Down Arrow Moves the cursor down one line in the text and selects
the lines of text.

Ctrl+Down Arrow ⌘+Down Arrow Moves the cursor to the end of the paragraph.

Ctrl+Shift+Down 
Arrow

⌥+Shift+Down 
Arrow

Moves the cursor to the end of the paragraph. Selects
the text in the paragraph from the cursor position to 
the end of the paragraph.

Home Moves the cursor to the beginning of the line.

Shift+Home Moves the cursor to the beginning of the line and 
selects the text from the cursor position.

Ctrl+Home Moves the cursor to the beginning of the text block on 
the slide.

End Moves the cursor to the end of the line.

Shift+End Moves the cursor to the end of the line and selects the
text from the cursor position.

Ctrl+End Moves the cursor to the end of the text block on the 
slide.

Ctrl+Del Delete the text from the cursor position to the end of 
the word.

Ctrl+Shift+Del Delete the text from the cursor position to the end of 
the sentence.

Ctrl+Backspace ⌘+Backspace Delete the text from the cursor position to the 
beginning of the word.

Ctrl+Shift+
Backspace

⌘+Shift+
Backspace

Delete the text from the cursor position to the 
beginning of the sentence.
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Slide Sorter and Slide Pane

Windows or Linux macOS Effect

Home Set the focus to the first slide.

End Set the focus to the last slide.

Left Arrow Left Arrow Set the focus to the previous slide.

Right Arrow Right Arrow Set the focus to the next slide.

Ctrl+Shift+Down 
Arrow

⌘+Shift+Down 
Arrow

Move selected slides down one position in Slide 
Sorter view. With multiple slides selected, the slides 
are moved together with the last selected slide in the 
list.

Ctrl+Shift+Up 
Arrow

⌘+Shift+Up 
Arrow

Move selected slides up one position in Slide Sorter 
view. With multiple slides selected, the slides are 
moved together with the first selected slide in the list.

Ctrl+Shift+End Move selected slides to end of Slide Sorter list.

Ctrl+Shift+Home Move selected slides to start of Slide Sorter list.

Enter Enter
Change to Normal view with the active slide when in 
Slide Sorter view. Add a new slide when in Slide 
Pane.

Menu keyboard shortcuts

The keyboard shortcuts listed in the following tables are available in each menu category on the 
Menu bar. The tables give the menu item or sub-item, operating system validity, and the effect or 
purpose of the shortcut.

Note

The menus listed below are in the same order as displayed on the Menu bar from
left to right.

File menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

New > 
Presentation

Ctrl+N ⌘+N Opens a new presentation

New > Templates
Shift+
Ctrl+N ⌘+Shift+N Opens the Templates dialog

Open Ctrl+O ⌘+O Opens a file browser for navigation to a folder 
and selecting a document.

Save Ctrl+S ⌘+S Saves the open document.

Save As
Ctrl+
Shift+S

⌘+Shift+S Opens the Save as file browser to save the 
open document as a new document.

Print Ctrl+P ⌘+P Opens the Print dialog to select how the 
document is printed

Exit LibreOffice Ctrl+Q ⌘+Q Closes the open file and quits LibreOffice

Menu keyboard shortcuts | 9



Edit Menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Undo Ctrl+Z ⌘+Z Undoes the previous editing action.

Redo Ctrl+Y ⌘+Y Reverses the action of the last Undo command.

Cut Ctrl+X ⌘+X Deletes the selected object and places it on the 
clipboard.

Copy Ctrl+C ⌘+C Copies the selected object to the clipboard.

Paste Ctrl+V ⌘+V Places the object on the clipboard into the 
document.

Paste Special > 
Paste 
Unformatted Text

Ctrl+Shift+
Alt+V

+⌘ ⌥+
Shift+V

Paste copied text at the cursor position without 
any formatting.

Paste Special > 
Paste Special

Ctrl+
Shift+V

⌘+Shift+V
Opens the Paste Special dialog to paste the 
contents of the clipboard at the cursor position 
in a format that is specified.

Select All Ctrl+A ⌘+A Selects all objects on a slide.

Find Ctrl+F ⌘+F Opens the Find toolbar

Find and Replace Ctrl+H +⌥ ⌘+F Opens the Find and Replace dialog

Points F8 F8
Opens the Edit Points toolbar if there is an 
object on the slide that uses editable points, for 
example a freeform line.

Edit Mode
Ctrl+
Shift+M ⌘+Shift+M

Switches on or off the Impress edit mode. 
When switched off, a slide show is displayed in 
read only mode.

View menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Rulers
Ctrl+
Shift+R ⌘+Shift+R Switches the rulers off and on in the 

Workspace.

Sidebar Ctrl+F5 ⌘+F5 Opens or closes the Sidebar.

Styles F11 ⌘+T Opens or closes the Styles deck on the 
Sidebar.

Navigator
Ctrl+
Shift+F5 ⌘+Shift+F5 Opens the Navigator.

Insert menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Object > 
Formula Object

Ctrl+Alt+= +⌥ ⌘+= Inserts a formula into the slide

Text Box F2 F2 Switches to text edit mode and opens the 
Text Formatting toolbar.
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Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Comment Ctrl+Alt+C +⌘ ⌥+C Inserts a new comment box onto the selected
slide.

Hyperlink Ctrl+K ⌘+K Opens the Hyperlink dialog.

Formatting Mark
> Insert non-
breaking space

Ctrl+Shift+
Space

⌘+Shift+
Space

Inserts a non-breaking space at the cursor 
position.

Formatting Mark
> Insert Narrow 
No-break Space

Ctrl+
Shift+F5 ⌥+Shift+F5 Inserts a no-breaking space at the cursor 

position.

Formatting Mark
> No-width 
Optional Break

Ctrl+/ ⌘+/ Inserts a no-width no optional break at the 
cursor position.

Format menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Text > Bold Ctrl+B ⌘+B Applies Bold format to selected text.

Text > Italic Ctrl+I ⌘+I Applies Italic format to selected text.

Text > 
Superscript

Ctrl+
Shift+P

+⌘ ⌥+C Applies superscript format to selected text.

Text > Subscript
Ctrl+
Shift+B

⌘+Shift+B Applies subscript format to selected text.

Text > Increase 
Size

Ctrl+] ⌘+] Increases the point size of selected text.

Text > Decrease 
Size

Ctrl+[ ⌘+[ Decreases the point size of selected text.

Spacing > Line 
Spacing 1

Ctrl+1 ⌘+1 Sets the line spacing in a paragraph to a single 
line.

Spacing Line 
Spacing 5

Ctrl+5 ⌘+5 Sets the line spacing in a paragraph to one and 
half lines.

Spacing > Line 
Spacing 2

Ctrl+2 ⌘+2 Sets the line spacing in a paragraph to two 
lines.

Align > Left Ctrl+L ⌘+L Sets the paragraph alignment to left aligned.

Align > Center Ctrl+E ⌘+E Sets the paragraph alignment to center aligned.

Align > Right Ctrl+R ⌘+R Sets the paragraph alignment to right aligned.

Align > Justified Ctrl+J ⌘+J Sets the paragraph alignment to justified.

Lists > Demote
Shift+Alt+
Right Arrow

Demotes a point to the next level when Outline 
view.

Lists > Promote
Shift+Alt+
Left Arrow

Promotes a point to the next level when in 
Outline view.

Lists > Move 
Down

Shift+Alt+
Down Arrow

⌥+Shift+
Down Arrow

Moves a point down the order when in Outline 
view.
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Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Lists > Move Up
Shift+Alt+
Up Arrow

⌥+Shift+Up 
Arrow

Moves a point up the order when in Outline 
view.

Clear Direct 
Formatting

Shift+
Ctrl+M ˄+Shift+M

Removes direct formatting from the selection. 
Direct formatting is formatting that is applied 
without using styles.

Styles > Manage 
Styles

F11 ⌘+T Opens or closes the Styles deck on the 
Sidebar.

Object and 
Shape > Position 
and Size

F4 F4 Opens the Position and Size dialog of a 
selected object.

Arrange > Bring 
to Front

Ctrl+
Shift++ ⌘+Shift++ Moves a selected object to the front of other 

objects.

Arrange > Bring 
Forward

Ctrl++ ⌘++ Moves a selected object in front of the forward 
object.

Arrange > Send 
Backward

Ctrl+- ⌘+- Moves a selected object behind the backward 
object.

Arrange > Send 
to Back

Ctrl+
Shift+- ⌘+Shift+- Moves a selected object to the back of other 

objects.

Group > Group
Ctrl+
Shift+G ⌘+Shift+G Group selected objects.

Group > Ungroup
Ctrl+Alt+
Shift+G

+ ⌘ ⌥+
Shift+G Ungroup selected group.

Group > Enter 
Group

F3 F3 Enter and edit a group of objects.

Group > Exit 
Group

Ctrl+F3 ⌘+F3 Exit a group of objects.

Slide menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

New Slide Ctrl+M ˄+M Inserts a new slide into the slide show.

Jump to Last 
Edited Slide

Alt+
Shift+F5 ⌥+Shift+F5 Opens the last slide edited in the document.

Move > Slide to 
Start

Ctrl+Shift+
Home

Moves the selected slide to the beginning of the
slide show.

Move > Slide Up
Ctrl+Shift+
Up

⌘+Shift+Up 
Arrow

Moves the selected slide above the previous 
slide. No function on the first slide.

Move > Slide 
Down

Ctrl+Shift+
Down

⌘+Shift+
Down Arrow

Moves the selected slide below the next slide. 
No function on the last slide.

Move > Slide to 
End

Ctrl+Shift+
End

Moves the selected slide to the end of the slide 
show.

Navigate > To 
Previous Slide

Page Up Up Arrow Switch to the previous slide. No function on the 
first slide.
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Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Navigate > To 
Next Slide

Page Down Down Arrow Switch to the next slide. No function on the last 
slide.

Slide Show menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Start from First 
Slide

F5 F5 Starts a slide show from the first slide.

Start from 
Current Slide

Shift+F5 Shift+F5 Starts a slide show at the slide where the slide 
show was previously stopped at.

Tools menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Spelling F7 ⌘+Shift+; Start spelling checker.

Automatic Spell 
Checking

Shift+F7 Shift+F7 Switches on or off the automatic spell 
checking.

Thesaurus Ctrl+F7 ⌘+F7
Opens the Thesaurus dialog for the language
being used. Impress has to be in text editing 
mode to access the thesaurus.

Extension 
Manager

Ctrl+Alt+E +⌘ ⌥+E Opens the Extension Manager dialog.

Options Alt+F12 ⌘+, Opens the Options LibreOffice dialog.

Windows menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

Closes Window Ctrl+W ⌘+W Closes the active window. If there is only one 
window, LibreOffice Impress closes.

Help menu

Menu item or 
sub-item

Windows or 
Linux

macOS Effect

LibreOffice Help F1 F1 Opens the browser application at the 
LibreOffice Help pages.
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Toolbar keyboard shortcuts

Impress provides several toolbars to help in creating slides and slide shows. Some of the tools 
on these Impress toolbars can be activated using a keyboard shortcut.

Note

The toolbars are listed in the same order that is displayed in the submenu that 
opens when clicking on View > Toolbars on the Menu bar.

Drawing

Tool name
Windows, Linux, or 
macOS

Effect

Insert Text Box F2 Switches to text edit mode and opens the Text 
Formatting toolbar.

Position and Size F4 Opens the Position and Size dialog of a selected 
object.

Points F8
Opens the Edit Points toolbar if there is an object on 
the slide that uses editable points, for example a 
freeform line.

Find

Tool name
Windows or 
Linux

macOS Effect

Find and Replace Ctrl+H +⌥ ⌘+F Opens the Find and Replace dialog

Form Design

Tool name
Windows or 
Linux

macOS Effect

Position and Size F4 F4 Opens the Position and Size dialog of a 
selected object.

Bring to Front
Ctrl+
Shift++

⌘+Shift++ Moves a selected object to the front of other 
objects.

Send to Back
Ctrl+
Shift+-

⌘+Shift+- Moves a selected object to the back of other 
objects.

Group
Ctrl+
Shift+G

⌘+Shift+G Group selected objects.

Ungroup
Ctrl+Alt+
Shift+G

+⌘ ⌥+
Shift+G Ungroup selected group.

Enter Group F3 F3 Enter and edit a group of objects.

Exit Group Ctrl+F3 ⌘+F3 Exit a group of objects.
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Image

Tool name
Windows or 
Linux

macOS Effect

Bring to Front
Ctrl+
Shift++ ⌘+Shift++ Moves a selected object to the front of other 

objects.

Bring Forward Ctrl++ ⌘++ Moves a selected object in front of the forward 
object.

Send Backward Ctrl+- ⌘+- Moves a selected object behind the backward 
object.

Send to Back
Ctrl+
Shift+- ⌘+Shift+- Moves a selected object to the back of other 

objects.

Line and Filling

Tool name
Windows or 
Linux

macOS Effect

Position and Size F4 F4 Opens the Position and Size dialog of a 
selected object.

Bring to Front
Ctrl+
Shift++

⌘+Shift++ Moves a selected object to the front of other 
objects.

Bring Forward Ctrl++ ⌘++ Moves a selected object in front of the forward 
object.

Send Backward Ctrl+- ⌘+- Moves a selected object behind the backward 
object.

Send to Back
Ctrl+
Shift+-

⌘+Shift+- Moves a selected object to the back of other 
objects.

Show the Styles 
Sidebar

F11 ⌘+T Opens the Styles deck on the Sidebar.

Outline

Tool name
Windows or 
Linux

macOS Effect

Demote
Shift+Alt+
Right Arrow

Demotes a point to the next level when Outline 
view.

Promote
Shift+Alt+
Left Arrow

Promotes a point to the next level when in 
Outline view.

Move Down
Shift+Alt+
Down Arrow

⌥+Shift 
+Down Arrow

Moves a point down the order when in Outline 
view.

Move Up
Shift+Alt+
Up Arrow

⌥+Shift+Up 
Arrow

Moves a point up the order when in Outline 
view.

Slide Sorter

Tool name
Windows or 
Linux

macOS Effect

Start from First 
Slide

F5 F5 Starts a slide show from the first slide
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Standard

Tool name
Windows or 
Linux

macOS Effect

New Ctrl+N ⌘+N Opens a new presentation document.

Templates
Ctrl+
Shift+N

⌘+Shift+N Opens the Templates dialog to create a new 
document using a template.

Open Ctrl+O ⌘+O Opens the Open file browser so you can 
navigate to a folder and select a document.

Save Ctrl+S ⌘+S Saves the open document.

Save As
Ctrl+
Shift+S ⌘+Shift+S Opens the Save as file browser so you can 

save the open document as a new document.

Edit Mode
Ctrl+
Shift+M ⌘+Shift+M Switches on edit mode when a document is in 

read only mode.

Print Ctrl+P ⌘+P Opens the Print dialog to select how the 
document is printed.

Cut Ctrl+X ⌘+X Deletes the selected object and places it on the 
clipboard.

Copy Ctrl+C ⌘+C Copies the selected object to the clipboard.

Paste Ctrl+V ⌘+V Places the object on the clipboard into the 
document.

Clear Direct 
Formatting

Ctrl+
Shift+M

⌘+Shift+M Removes direct formatting that has been 
applied without using styles.

Undo Ctrl+Z ⌘+Z Undoes the previous editing action.

Redo Ctrl+Y ⌘+Y Reverses the action of the last Undo command.

Find and Replace Ctrl+H +⌘ ⌥+F Opens the Find and Replace dialog.

Spelling F7 F7 Starts the spelling checker.

Toggle Automatic 
Spell

Shift+F7 Shift+F7 Switches on or off the automatic spell checking.

Start from First 
Slide

F5 F5 Starts a slide show.

Start from 
Current Slide

Shift+F5 Shift+F5 Starts a slide show at the slide where the slide 
show was previously stopped at.

Insert Text Box F2 F2 Switches to text edit mode and opens the Text 
Formatting toolbar.

Insert Hyperlink Ctrl+K ⌘+K Opens the Hyperlink dialog.

Standard (Single Mode)

Tool name
Windows or 
Linux

macOS Effect

New Ctrl+N ⌘+N Opens a new presentation document.

Open Ctrl+O ⌘+O Opens the Open file browser for navigation to a 
folder and select a document.

Save Ctrl+S ⌘+S Saves the open document.

16 | Appendix A, Keyboard Shortcuts



Tool name
Windows or 
Linux

macOS Effect

Print Ctrl+P ⌘+P Opens the Print dialog to select how the 
document is printed

Undo Ctrl+Z ⌘+Z Undoes the previous editing action.

Redo Ctrl+Y ⌘+Y Reverses the action of the last Undo command.

Insert Text Box F2 F2 Switches to text edit mode and opens the Text 
Formatting toolbar.

Position and Size F4 F4 Opens the Position and Size dialog of a 
selected object.

Group
Ctrl+
Shift+G ⌘+Shift+G Group selected objects.

Ungroup
Ctrl+Alt+
Shift+G

+⌘ ⌥+
Shift+G Ungroup selected group.

Enter Group F3 F3 Enter and edit a group of objects.

Exit Group Ctrl+F3 ⌘+F3 Exit a group of objects.

Start from First 
Slide

F5 F5 Starts a slide show from the first slide.

Start from 
Current Slide

Shift+F5 Shift+F5 Starts a slide show at the slide where the slide 
show was previously stopped at.

Standard (Viewing Mode)

Tool name
Windows or 
Linux

macOS Effect

Save As
Ctrl+
Shift+S

⌘+Shift+S Opens the Save as file browser to save the 
open document as a new document.

Edit Mode
Ctrl+
Shift+M

⌘+Shift+M Switches on edit mode when a document is in 
read only mode.

Print Ctrl+P ⌘+P Opens the Print dialog to select how the 
document is printed.

Copy Ctrl+C ⌘+C Copies the selected object to the clipboard.

Find and Replace Ctrl+H +⌘ ⌥+F Opens the Find and Replace dialog.

Start from First 
Slide

F5 F5 Starts a slide show from the first slide.

Text

Tool name
Windows or 
Linux

macOS Effect

Insert Text Box F2 F2 Switches to text edit mode and opens the Text 
Formatting toolbar.
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